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Objetivos y Resultados del Aprendizaje

• Aprender cómo trabajar con imágenes de teledetección acuática utilizando 

SeaDAS, el software de procesamiento de imágenes de la NASA

• Resultados del Aprendizaje:

– Adquirir conocimiento sobre productos informáticos de la teledetección 

acuática

– Adquirir conocimiento sobre el procesamiento de imágenes por teledetección

https://arset.gsfc.nasa.gov/
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Recursos Adicionales

• Introducción a SeaDAS (2017): https://seadas.gsfc.nasa.gov/docs/SeaDAS_Intro.pdf

• Herramientas SeaDAS (2017): https://seadas.gsfc.nasa.gov/docs/SeaDAS_Tools.pdf

• Un Paseo (Walk Through) Exploratorio: 

https://seadas.gsfc.nasa.gov/docs/SeaDAS_Walk_Through.pdf

• SeaDAS- Páginas de Ayuda: https://seadas.gsfc.nasa.gov/help/

https://arset.gsfc.nasa.gov/
https://seadas.gsfc.nasa.gov/docs/SeaDAS_Intro.pdf
https://seadas.gsfc.nasa.gov/docs/SeaDAS_Tools.pdf
https://seadas.gsfc.nasa.gov/docs/SeaDAS_Walk_Through.pdf
https://seadas.gsfc.nasa.gov/help/
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Ubicación del Estudio: Desembocadura del Río Suwannee, 

Florida, EE.UU.

https://arset.gsfc.nasa.gov/


Funcionalidad Básica de SeaDAS
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Descargar Datos

• En la Demostración de la Parte 1, recibieron instrucciones sobre cómo descargar 

los datos para este ejercicio. También puede encontrar los datos en la página 

web del curso. Los archivos Aqua-MODIS para este ejercicio son: 

– A2015051184000.L2_LAC_OC.nc

– A2015051184000.L2_LAC_IOP.nc

– A2015051184000.L2_LAC_SST.nc

• Guarde estos archivos en una carpeta que no esté en una ubicación muy 

profunda en la estructura de sus directorios.

https://arset.gsfc.nasa.gov/
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Iniciar SeaDAS

• Este es el visualizador preprogramado

• Puede que algunas de las capturas de 
pantalla en este ejercicio no se vean 
exactamente como lo que usted vea. 
Esto está bien. 

• El propósito the este ejercicio servir de 
orientación sobre cómo procesar 
imágenes

• La discrepancia podría ser debido a: 

– el sistema de visualización de su 
computadora

– su versión de SeaDAS 

– alguna configuración del visualizador 
definida por el usuario

https://arset.gsfc.nasa.gov/
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Capacidades de Funcionalidad Básica en SeaDAS

• En este ejercicio aprenderá:

– cómo abrir un archivo

– cómo abrir rásteres

– funcionalidades básicas de SeaDAS

• Este documento provee direcciones generales sobre cómo utilizar SeaDAS. Note 

que no se explicará cada paso. A medida que vaya dominando las diferentes 

partes, las instrucciones supondrán una mayor autonomía por su parte.

• no hay datos

• sincronización

• crear barra de 
colores

• exportar imagen

• máscaras del suelo 

• banderas

• ajustar barra de 

colores

• reproyectar

• ampliación

• ubicación en el 

mapa

• líneas cuadriculares

• recortar

https://arset.gsfc.nasa.gov/
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Abrir un Archivo

1. En el menú de barra en SeaDAS, haga clic en File > 

Open y se abrirá una ventanilla

2. Navegue a la carpeta donde guardó las imágenes y 

haga clic en el archivo llamado:

– A2015051184000.L2_LAC_OC.nc

3. Seleccione el botón Open Product. Verá aparecer el 

archivo en el panel File Manager de la ventanilla del 

visualizador de SeaDAS. 

4. Usando so mouse, ajuste el ancho de este panel para 

que pueda ver el nombre completo del archivo. Haga 

clic en cada uno de los tres triángulos al lado de 

Metadata, Flag Bit Coding y Rasters para expandir la 

visualización.

https://arset.gsfc.nasa.gov/
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Explore Algunos Atributos de los Archivos

• Dese un tiempo para hacer clic en cada uno de los atributos bajo las carpetas Metadata
y Flag Bit Coding

• Se irán abriendo ventanillas mientras los vaya repasando para brindar información como 

los atributos del paso superior satelital y del sensor, la ubicación y la hora, al ángulo solar 

ambiental y las propiedades ópticas atmosféricas, unidades para los observaciones etc.

• Para los propósitos de este ejercicio, no vamos a profundizar en los valores de los 

metadatos. 

• A medida que usted se haga más proficiente en el procesamiento de imágenes, es una 

buena idea referirse a estos archivos para entender mejor las condiciones bajo las que las 

imágenes se recolectaron y si es que hubo errores de procesamiento. 

• Cierre todas las ventanillas que se abrieron cuando estuvo repasando Metadata y Flag Bit 

Coding

• Colapse esas carpetas haciendo clic en el triángulo a la izquierda del nombre de la 

carpeta. 

https://arset.gsfc.nasa.gov/
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Eligiendo un Ráster

• Cuando uno explora las imágenes en un servidor como NASA 

Worldview, las imágenes de clorofila-a y temperatura superficial 

marina (SST) están entre las más fáciles de ver. Los archivos de 

datos individuales que puede descarcar del navegador de Nivel 

1 y 2 incluyen mucho más que clorofila-a y SST

• Fíjese la selección de rásteres en el File Manager. Los productos 

informáticos incluyen:
– Remote Sensing Reflectance at 10 wavelengths (Rrs)

– chlorophyll-a (chlor_a)

– diffuse attenuation of light at wavelength 490 nm – a proxy for particles (Kd_490)

– particulate inorganic carbon (pic)

– particulate organic carbon (poc)

– instantaneous photosynthetically active radiation, or light from 400 – 700 nm (ipar)

– normalized fluorescence line height – a proxy for phytoplankton biomass measured in a 

different part of the spectrum than chlor_a (nflh)

– l2_flags

– Location data

https://arset.gsfc.nasa.gov/
https://worldview.earthdata.nasa.gov/
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Eligiendo un Ráster

5. Haga clic dos veces en chlor_a en el 

archivo 

A2015051184000.L2_LAC_OC.nc file

– Note que faltan los datos de la SST 

en este archivo

– Recuerde que este archivo tiene 

‘OC’ anexado a él para indicar 

‘color oceánico’

– También queremos ver la imagen de 

la SST. 

https://arset.gsfc.nasa.gov/
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Visualización de la Imagen de la SST

6. Siguiendo las instrucciones desde el Paso 1, 
abra el archivo llamado: 

A2015051184000.L2_LAC_SST.nc

7. Haga clic dos veces en SST debajo de los 

rásteres en el archivo 

A2015051184000.L2_LAC_SST.nc

– Queremos observar la columna del río 

Suwannee

– Este río naturalmente tiene “aguas 

negras”, lo cual significa que tiene altas 

concentraciones de materia orgánica 

disuelta coloreada (CDOM) en e

– Para observar la CDOM, querremos usar 

un producto informático llamado 

adg_443_giop

https://arset.gsfc.nasa.gov/
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Observe la CDOM

• adg_443_giop e una estimación del 

coeficiente de abosrción de material 

no algal más CDOM (adg ) a 443 nm 

en m-1

– Recuerde que la absorción es una 

propiedad óptica inherente (IOP)

8. Siga las mismas instrucciones para 

abrir archivos y abra el archivo 

llamado: 

A2015051184000.L2_LAC_IOP.nc

9. Haga clic dos veces en el ráster 

adg_443_giop en el archivo 

A2015051184000.L2_LAC_IOP.nc 

https://arset.gsfc.nasa.gov/
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Compare Clorofila, SST y CDOM

10. Haga clic en la pestaña chlor_a en la ventanilla de visualización principal

– Dese un tiempo ahora para mover la imagen con su mouse y practicar con las 

herramientas de selección y ampliación:

11. Intente ampliar la zona de Suwannee, Florida

– Observe los atributos marítimos

– Piense sobre lo que significan estos colores

– Note que esta imagen aún no ha sido reproyectada. Vamos a llegar a esto 

después. Por ahora vamos a intentar utilizar algunas de las herramientas 

básicas de SeaDAS.

https://arset.gsfc.nasa.gov/
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No Data (No hay datos)

1. Haga clic en el icono de No Data en la barra de herramientas

– Esta acción hará que los valores donde no hay datos en esta 

capa se vuelvan grises

2. Ajuste el tamaño del panel a la derechapara poder leer la 

información del panel Pixel Info

3. Usando su mouse, repase las áreas donde no hay datos y también 

donde los hay

4. Revise los valores para chlor_a y fíjese cómo cambian entre 

regiones sin datos y otras con datos en la imagen

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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No Data

No Data

Land Masks
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Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar
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Export Image

Reproject
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https://arset.gsfc.nasa.gov/
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No Data

5. Note the chlor_a values in the Pixel Info window

6. My mouse (not visible on slide 18) was hovering over an area to 

the west of Tampa, FL. Chlor_a had a value of 0.38838354

7. Repeat the No Data step with the SST and adg_443_giop images 

on your own time

8. Save your session by clicking on File > Session Save

9. Navigate to the folder where the data file is located 

10. Name the session SuwaneeR.seadas and select Save

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Apply a Land Mask (Aplicar Máscara al Suelo)

1. Revise las pestañas al fondo del panel File 

Manager. Haga clic en la que dice Mask.

2. Haga clic en la casilla al lado de la máscara 

llamada Land.

– Actívela y desactívela. ¿Qué cree que esta 

máscara sea? Desactive CLDICE.

3. Cambie el color de la máscara Land haciendo clic 

dos veces en el cuadro de colores para esa 

selección de máscara. Ajuste el color de la máscara.

4. Repita con SST y adg_443_giop en su propio tiempo.

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Apply a Land Mask (Aplicar Máscara al Suelo)

No Data

Land Masks

Zooming
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Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Apply a Land Mask (Aplicar Máscara al Suelo)

5. Guarde su sesión haciendo clic en File > Save As

6. Navegue a la carpeta de datos. Le

preguntará si desea guardar en formato

BEAM-DIMAP. Haga clic en Yes. 

7. Haga clic en cada pestaña en el

visualizador y repita estas instrucciones para guardar para SST y 

adg_443_giop en su propio tiempo. 

8. Guarde el archivo con el valor preprogramado:

– A2015051184000.L2_LAC_OC.dim

– A2015051184000.L2_LAC_SST.dim

– A2015051184000.L2_LAC_IOP.dim.  

9. Tome un momento para guardar la sesión a SuwaneeR.seadas

utilizando las instrucciones anteriores

No Data
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Export Image
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https://arset.gsfc.nasa.gov/
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Zooming with Navigation (Ampliación con Navegación)

1. Revise el panel inferior derecho de la ventanilla llamado 

Navigation Controls

2. Tome un poco de tiempo ahora para ampliar y reducir con estos 

controles en cada una de las tres pestañas abiertas

3. Detenga su mouse sobre cada una de las lupas para ver una 

descripción de la herramienta en la pequeña ventanilla que da 

información sobre esta

4. Amplíelo todo (Zoom All)

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Synchronize (Sincronizar)

1. Vaya al menú de barra Window > Tile Horizontally

2. Haga clic en la ventanilla de chlor_a y en Zoom All

– Note que la ampliación no cambió para la ventanilla SST

– A menudo, cuanto exploramos múltiples archivos de imágenes, 

deseamos sincronizar los controles

3. Para sincronizar las dos capas que estamos observando, haga clic 

en la herramienta de sincronización en la ventanilla 

Navigation Controls

• Ahora , cuando utilize el zoom o paneo en una ventanilla, ambas 

estarán sincronizadas. Cuando haya acabado, haga clic en la 

herramienta de sincronización para desactivarla

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar
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Export Image
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https://arset.gsfc.nasa.gov/
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Map Location (Ubicación en el Mapa)

1. Arrastre el panel World Map Location para sacarlo de la ventanilla, 
cambie el tamaño y haga clic en el botón de ampliación en la 
parte inferior derecha.

– Esto le mostrará en qué parte del mundo está la muestra de imagen

2. Haga clic con el botón derecho en la parte superior de la 
ventanilla y de-seleccione Floating para regresarlo al visualizador

3. Haga clic en el zoom en el panel World Map Location

4. Cierre el panel World Map Location para que haya más espacio

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar
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https://arset.gsfc.nasa.gov/
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Flags (and Pins) (Banderas [y “Pines” o Marcas de Localización])

1. Bajo el panel Rasters, haga clic en el icono Flags

Esto abrirá el panel Flags.

2. Cierre el panel Navigation Controls

3. En el panel Pixel Info, cierre las secciones Geo-

location y Rasters haciendo clic en la X en la parte 

derecha del panel

4. Desplace el mouse sobre la escena. “Invalid pos.” se 

muestra consistente a lo loargo de la lista de banderas: 

https://oceancolor.gsfc.nasa.gov/atbd/ocl2flags/

5. Haga clic en la herramienta “pin”

6. Encuentre un punto un poco más hacia el océano 

en la desembocadura del río Suwannee

7. Haga clic en el punto mientras esté activa la 

herramienta pin. Puede que necesite ampliar un poco. 

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
https://oceancolor.gsfc.nasa.gov/atbd/ocl2flags/
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Flags (and Pins) (Banderas [y “Pines” o Marcas de Localización])

8. Mire hacia la tierra desde esta posición y verá los pixeles grises 
característicos de “no data.” Marce esa ubicación gris con un pin

9. Cambie de la herramienta pin a la herramienta de selección (la 
flecha)

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Flags (and Pins) (Banderas [y “Pines” o Marcas de Localización])

10. Tome turnos haciendo clic cerca de la punta de cada marcador 
y observe como cambia la información de las banderas. 

– ¿Cuáles banderas están presentes en la punta del Pin 2? 

11. Ahora, haga clic en la herramienta para ordenar los pines.  Esto 
abrirá la siguiente ventanilla:

10. Haga clic en cada fila para resaltarla y haga clic en el icono de la 
papelera en la parte derecha de la ventanilla para borrarla. 

11. Remueva todos los pines de esta manera y ahora cierre el 
administrador de pines

12. Haga clic en View > Reset to Default Layout para reestablecer la 
configuración de paneles preprogramada del visualizador

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

1. Haga clic en la ventanilla de chlor_a

2. En la parte inferior izquierda del visualizador, haga 

clic en la pestaña Color Manager

3. El botón Basic ya está seleccionado. Bajo Scheme, 

haga clic en Scheme Selector

4. Revise las opciones disponibles. Cierre el Chl (UniBr-

Palette), lo cual cargará el archivo Cpd

universal_bluered.cpd

5. Fíjese en la parte superior del panel Color Manager 

y haga clic en el botón the Sliders

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar
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Export Image

Reproject
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

6. Hay bastante funcionalidad en este panel. Para 

nuestros propósitos, vamos a ajustar el color 

eligiendo una gama de 95% en vez de 100%.

7. Haga clic en el icono en la parte superior derecha 

del administrador de colores llamado 95%

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

• Note la diferencia en los histogramas antes y después de ajustar la 

gama cromática para estos datos

• ¿Qué cree usted que haya hecho este ajuste? 

• ¿Por qué cree que podríamos querer hacer semejante ajuste?? 

No Data
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

8. Tome un tiempo para ajustar la gama, Log10 y correspondencia 
de histogramas. Observe cómo cambia la visualización de las 
imágenes.

9. Cuando haya terminado, reponga la configuración de Log10=on
(looks dark), 100% y Histogram matching=none

10. Haga clic en el botón al lado de Basic en la parte superior del 
panel Color Manager e intente cambiar el archivo CPD para 
cambiar la paleta de colores por alguna de las varias opciones. 
Explore diferentes  paletas.

11. Cuando haya terminado, regrese a la paleta 
universal_bluered.cpd. Esta es una paleta apta para personas con 
daltonismo. Leer más sobre esta paleta en SeaDAS »

12. Para ajustar la escala de colores en el panel Color Manager, 
haga clic en Set from Band Data

No Data
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Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar
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https://arset.gsfc.nasa.gov/
https://seadas.gsfc.nasa.gov/help/color-blind-config/ColorBlindConfig.html
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Adjusting the Color Bar (Ajustar la Barra Cromática)

13. Revise la imagen. Amplía si hay atributos que necesita ver más 

claramente.

14. En el panel Pixel Info a la derecha, haga clic en el icono 

Show/Hide Rasters para poder ver información acerca de la 

imagen mientras panea su mouse sobre la escena. 

15. Cierre el panel de Flags si es que aún sigue abierta

16. Panee su mouse sobre la escena asegurándose de fijarse en 

regiones de valores bajos (azul en esta paleta) y valores altos.

– Si no está viendo los valores, desactive Snap to selected pin

17. Vuelva al panel de Color Manager

18. Haga clic en Set from Band Data

No Data
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

19. Haga clic dos veces en Max: cell, teclee 15, y toque Enter. ¿Qué 
sucede?

20. Intente configurar el mínimo y el máximo manualmente

– aquí parece haber una falla en SeaDAS

21. Si no encuentra ningún cambio, vuelva a hacer clic en Set from Band 
Data vuelva a intentar.

– ¿Cuál rango le parece bien a usted? 

Una región en particular suele tener concentraciones de clorofila típicas 
fuera de los períodos de floración. El occidente del estado de Florida tiene 
una concentración de clorofila media de 0,26 μg/L (o mg/m3) y u rango de 
0,2 a 13,3 mg/L. 

Tomando esto en cuenta, intente elegir un rango de valores de clorifila
reducido que lo que se está sugiriendo del rango completo de los datos de 
banda. Haga esto para obtener un rango dinámico más razonable. Note: 
que la pantalla muestra una escala logarítmica por defecto.

No Data
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https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

22. Repita la configuración de la paleta y los rangos para los 

productos informáticos SST y adg_443_giop data en su propio 

tiempo. Para SST utilice bar Scheme > SST. Para adg_443_giop elija 

la misma esquema que usó para clorofila. 

23. Utilice su propio criterio y los datos del Pixel Info mientras mueve su 

mouse sobre la imagen para elegir un rango Min/Max significante 

para  SST y adg_443_giop

Nota importante: sus

imágenes no van a ser

idénticas a estas porque

su elección Min/Max

va a ser diferente.

24. Haga clic en Window > 

Tile Horizontally

No Data

Land Masks

Zooming

Synchronizing

Map Location

Flags (and Pins)

Adjust Color Bar

Create Color Bar

Gridlines

Export Image

Reproject

Crop

https://arset.gsfc.nasa.gov/
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Adjusting the Color Bar (Ajustar la Barra Cromática)

25. Ordene su visualizador sincronizando sus ventanillas y  ajustando el 

tamaño de los paneles para maximizar la visualización de las 

imágenes

26. Guarde la sesión

27. Mire el panel de adg_433_giop. 

– ¿Qué cree ud. que esté sucediendo en la desembocadura del 

río Suwannee? 

– ¿Qué dice la bandera L2 sobre esto? 
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https://arset.gsfc.nasa.gov/


NASA’s Applied Remote Sensing Training Program 37

Create a Color Bar (Crear una Barra Cromática)

1. Haga clic en la ventanilla chlor_a para que esté activa

2. Revise la barra de herramientas. Encuentre y haga clic en la 
herramienta de barra cromática

3. Haga clic en Create Layer

4. Amplíe todo      para ver la barra cromática
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Create a Color Bar (Crear una Barra Cromática)

5. La imagen tiene una barra cromática, pero es pequeña y difícil 
de ver

6. Haga clic en la herramienta de la barra de color nuevamente. 
Esta vez, cambie la configuración de la siguiente manera: Title > 
chlor_a, Units > (mg m^-3), Size Scaling > 90.0, Location > Outside
Image, Location y Alignment > Bottom Center para poner la barra 
cromática fuera de la imagen. Deje las otras configuraciones 
como están.
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Create a Color Bar (Crear una Barra Cromática)

7. Haga clic en la vista previa para ver si es lo que 

quiere. Cuando esté satisfecha/-o, haga clic en 

Create Layer. La salida debe verse como la imagen 

a la derecha.

8. Repita los pasos para crear una barra cromática 

para sus imágenes SST y adg_443_giop en su propio 

tiempo. Asegúrese de usar títulos y unidades 

apropiados para esos productos informáticos: SST 

(grados C), adg (m^-1).
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Create a Color Bar (Crear una Barra Cromática)

1. Haga clic e el panel chlor_a y cámbiele el tamaño para poder ver 

la imagen entera

2. Revise la barra de herramientas y encuentre la herramienta de 

líneas de cuadrícula y haga clic en ella: 

3. Mire su escena. Esta herramienta le agrega líneas de cuadrícula a 

su imagen. 

4. Mire detenidamente la parte inferior de la escena cerca de la 

barra cromática. La notación para las coordenadas está 

chocándose con la barra cromática.

5. Esto se puede remediar. Verifique que la herramienta de líneas de 

cuadrícula esté activa y haga clic en la herramienta Edit Layers 

Properties: 
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Create a Color Bar (Crear una Barra Cromática) 

6. La siguiente ventanilla abrirá. Haga clic en Show Longitude Labels

– South para remover las etiquetas de longitud para que ya no 

estén en conflico con la barra cromática

7. Cierre la ventanilla después de hacer el cambio
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Create a Color Bar (Crear una Barra Cromática)

• Note que las etiquetas en la parte superior de la imagen ya no 

están ahía

• Mietnras tenga las líneas de cuadrícula activas puede volver a la 

herramienta Edit Layers para hacer cambios en el formato de las 

líneas de cuadrícula

• Estos cambios serán preservados cuando exporte la imagen a un 

archivo de imagen

8. Repita este paso de las líneas de cuadrícula con las imágenes SST 

y adg_443_giop en su propio tiempo
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Export Image (Exportar Imagen)

1. Ahora tiene una imagen con con una barra cromática y líneas de 

cuadrícula. Amplíe todo para todas las imágenes.

2. Cambie el tamaño de las ventanillas de las imágenes para poder 

solo el área que desea exportar. 

3. Asegúrese que las líneas de cuadrícula estén visibles en la ventanilla

4. Haga clic con el botón 

derecho en la imagen

que quiera exportar y 

haga clic en Export Image

5. Abrirá una bentanilla
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Export Image (Exportar Imagen)

6. Podría elegir simplemente guardar la imagen con las configuraciones 

preprogramadas, pero eso le va a dar una imagen de resolución bruta.

7. En vez de eso, sería buena idea ajustar el ancho y alto del 

tamaño de la imagen

8. Guárdela con el nombre del archivo y con “_image” agregado al 

final del nombre como en este ejemplo: 
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Export Image (Exportar Imagen)

9. Repita estos paso para las imágenes SST y adg_443_giop en su 

propio tiempo

• Si no está satisfecha/-o con el producto, cambie las opciones de 

líneas de cuadrícula, barra cromática o exportación para crear una 

imagen que le guste.

10. Recuerde guardar cada ejemplo que produzca con un nuevo 

nombre usando Save As, a no ser que quiera borrar sus intentos 

anteriores
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Reproject (Reproyectar)

• ¡Felicidades por haber llegado hasta acá! Las imágenes que produjo 

en la sección anterior no están proyectados como los necesitamos, 

así que las vamos a reproyectar y exportar nuevas imágenes

1. Cierre los archivos SST y adg_443_giop

2. Haga clic en el panel chlor_a pane para que sea la capa activa

3. Haga clic en la herramienta de proyección cartográfica

4. Esto abrirá la ventanilla Create Reprojected File. Use las imágenes 

en la siquiente diapositiva para cambiar las pestañas en esta 

ventanilla para que sean iguales. Asegúrese que la ruta de 

directorios que ingrese sea la correcta para el sistema que utilice.
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Reproject (Reproyectar)
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Reproject (Reproyectar)

7. Use el método de muestreo bilineal

8. Haga clic en Run cuando vea que sus configuraciones son 

satisfactorias

9. Cuando acabe el proceso, haga clic en Close

10. Estas confirugraciones automáticamente guardaran el archivo 

nuevo, reproyectado y lo abrirán en SeaDAS. 

11. Si quiere ver cómo funciona la proyección, sin guardar, haga clic 

para desactivar el botón Save file as en la pestaña I/O 

Parameters de esta ventana

12. Cuando acabe el proceso, abra la capa chlor_a del archivo con 

la nueva reproyección

13. Cierre el archivo anterior
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Reproject (Reproyectar)
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Crop (Recortar)

• La imdagen de la capa de clorofila-a reproyectada ilustra la 

necesidad de recortar la imagen para mostrar la región de interés

• Hay varios métodos de recortar con SeaDAS. Este es el método más 

sencillo y directo

1. Abra la herramienta para recortar      en el menú de barra

2. Este abrirá la ventanilla Create Cropped File

3. Quédese en la configuración Spatial Subset

4. Si sabe las coordenadas geográficas para la región de interés, 

haga clic en el botón llamado Geo Coordinates

5. Si tiene dudas, haga clic en el botón Pixel Coordinates y configure 

los límites manualmente ajustando la región rectangular en el 

panel a la izquierda de la ventanilla donde hará el recorte
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Crop (Recortar)

6. Cuando esté satisfecho/-a con su cuadro delimitador, vuelva a 

Geo Coordinates y anote todos los valores de latitud y longitud 

para el cuadro delimitador

7. Deje las demás configuraciones con su valor preprogramado

8. Haga clic en OK
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Crop (Recortar)

9. Esto crea un nuevo archivo visible en el File Manager. Note el 

color raro al lado del icono de capas donde está el nombre del 

archivo(parece una torre de panqueques). Esto nos informa que 

el archivo necesita ser guardado. 

10. Tome un momento para abrir un ráster y observar si es que el 

recorte se hizo de acuerdo con su preferencia.

11. Haga clic con el botón derecho y elija Save As

12. Se abrirá una nueva ventanilla con un nombre preprogramado 

para el archivo. Cambie el nombre para no borrar el archivo 

original sin querer.

13. Llámelo A2015051184000.L2_LAC_OC_reprojected_subset.dim y 

haga clic en Save
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Crop (Recortar)
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Crop (Recortar)

14. Tome un momento para cerrar algunos de los archivos que tiene 

abiertos en el File Manager. 

15. Depende de usted si quiere guardar algunos de los cambios que 

le hizo al archivo

16. El archivo recién recortado debería ser el único archivo que aún 

están en el File Manager

17. Repita los pasos para ajustar el color, la barra cromática, líneas de 

cuadrícula y exportación para producir una imagen nueva, 

exportada de esta región reproyectada y recortada

18. Cuando termine, guarde la sesión y cierre SeaDAS

19. En su propio tiempo, repita estos pasos para las imágenes SST y 

adg_443_giop. Nota: Asegúrese de usar las mismas coordenadas 

geográficas para chlor_a cuando recorte estos otros archivos
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